Index

o Symbols & Numerics ®

<jdoc:include> element, 227

| _ (pipe underscore) characters
(submenu), 61

? (question mark) character, and dynamic
page, 251

1.0 Native icon, 268

1.5 Native icon, 283

o/ ] o

Absolute Beginners Guide to Joomla Web
site, 292
Access Level list (Menu Item Manager), 141
accessing
article editor, 147
Article Manager, 64
Banner Manager, 187
Category Manager, 99
Contact Manager, 241
Extension Manager, 229
Global Configuration page, 56, 177
Menu Manager, 53, 59
Microsoft Paint, 74
Module Manager, 56
Plugin Manager, 151
Poll Manager, 68
Registration page, 201
Section Manager, 96
Template Manager, 76, 216
Trash Manager, 121
User Manager, 166
account, user-created, 236. See also
administrator-created account
ad
banner type, 191-192, 193
editing, 188
Add New Article icon (administrator
control panel), 50

admin username, 240
Administration Login, 43, 48
administration page (Advertisement
module)
Banner Manager, 187-189
description of, 183, 184
Details pane, 185
Menu Assignment pane, 186
Parameters pane (administration page),
186-187
administrator
logging on as, 43-44, 48
password for, 32
administrator control panel
Add New Article icon, 50
administrator privileges, granting, 47-48
description of, 46-47
logging in to, 43-44
managers, 44, 48-49
user privileges, granting, 47
administrator privileges, granting, 47-48
Administrator tab (Module Manager), 57
administrator template, 217
Administrator user level
creating account, 239-240
description of, 47, 234
submitting articles, 172-173
administrator-created account
Administrator user, 47, 172-173, 234,
239-240
Author user, 47, 165-166, 171-174, 233,
237, 238
Editor user, 47, 165-166, 174-176, 233,
237, 238
Manager user, 47, 234, 239
Publisher user, 47, 165, 176, 233, 238-239
Registered user, 47, 233, 236-237
Super Administrator, 47, 234, 240
Advanced Settings section (Database
Configuration page), 31
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Advertisement module. See also
administration page (Advertisement
module)

Banner Manager, 187-189
description of, 183-184

Ajax-enabled search engine, 272-273

alias, 86

Apache Web server download Web site, 35

appearance, default, of site, 15, 16

Apply button (article editor), 52, 86

approving article, Administrator user level
and, 172-173

Archive module, 189-191

article editor

accessing, 147
article open in, 148
changing, 195
emoticons, 152
formatting articles with HTML tags,
154-156
Metadata options, 150, 205-206
options, 148
Pagebreak button, 161
Parameters - Advanced options, 149-150
Parameters - Article options, 149, 163
restoring default, 197
TinyMCE, 150-151
Article Layout page
description of, 89, 91
options, 136-137
Parameters - Advanced section, 137-138
Parameters - Basic section, 93, 137
Parameters - Component section, 138-139
Parameters - System section, 139
Article Manager
accessing, 64
Archive button, 189
articles displayed in, 112
description of, 46
Filter text box, 88
filtered articles in, 113
Hits column, 176-177
Keywords text box, 257-258

Metadata Information pane, 258
reordering articles in, 113-114
target Web pages and, 126, 127
viewing new article in, 87
Article Rating/Voting drop-down menu, 141
Article Submission Layout page, 168,
169-170
article submission page
creating, 167-170
viewing link to, 170-171
articles
adding to categories, 102-104
adding to Main menu as separate menu
items, 105
applying list layout to, 130-136
archiving, 189-191
Author user level and, 171-174
changing number of columns in, 159-160
creating, 50-52, 131-132
description of, 46
displaying list of archived, 190-191
Editor user level and, 174-176
emoticons, adding to, 151-152
filtering, 65-66
formatting with HTML tags, 154-156
hiding author name, 142-144
images, adding to, 152-154
inserting multimedia into, 154
keywords for, 204-206
in list layout, changing order of, 134-136
menu items and, 52-53, 88-95
opening in new windows, 141-142
order of, changing, 112-116
Publisher user level and, 176
publishing in future, 162-163
showing ratings of, 140-141
stopping publishing in future, 163-164
table, creating in, 156-157
table of contents, creating for, 160-162
translations of, 286, 287
tweaking titles of, 53-55
uncategorized, 85-88
unpublishing, 66-67
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unpublishing in present, 164-165
user privileges and, 47
viewing, 64-65
article-selection page, 93
article-to-article link, showing, 144
assigning template by page, 220
attributes of menu item, setting, 92
author name, hiding, 142-144
Author user level
creating account, 237, 238
description of, 47, 165-166, 233
options for, 171-174
automating search engine optimization, 262

ol e

back end
administrator template, 217
description of, 46
as timing out, 56
back-end page, Preview link, 230
Background Variation drop-down menu
(Edit Template page), 220
backup and restore extension, 288
Backup Old Tables option, 31
banner ad
changing, 192, 193
description of, 191-192
Banner Manager, 187-189
Banners module, 94, 191-193
Beez template
assigning by page, 220-221
making default, 218
as site template, 217
switching to, 79-80
as tableless, 227
Best of Joomla Web site, 301-302
blog extension, 286, 287
Blog Layout, 107, 109. See also Category
Blog Layout page
blog layout, list layout compared to, 130
breadcrumbs, 144
Breadcrumbs module, 58, 194

oo

C (component) icon, 269
Cascading Style Sheets (CSS), 12-13
Cascading Style Sheets (CSS) file, templates
and, 75
categories
adding articles to, 102-104
adding menu items to Main menu that
point to, 106
applying list layout to articles in, 130-136
creating, 99-101, 131
default, 98-99
Extensions site, 267-268
organizing site in, 83-84
Category Blog Layout page
category menu item, creating, 107-108
Parameters - Advanced section, 115
turning article title into link and, 139-140
Category drop-down menu (article-
selection page), 93
Category List Layout page, 133
Category Manager
accessing, 99
changing section category is assigned
to, 99
new category, creating, 99-101
category page
adding Read More link to, 109-112
creating, 124-125
reordering articles in, 114-116
Change Menu Item page, 146
Choose Language page, 26-27
City of Longwood site, 8-9
clock. jpg image, 152-153
CMS Tutorials and Reviews section
(Needforcontent.com), 312
CMSes (content management systems)
description of, 1, 8
dynamic Web pages via, 13-14
HTML pages and, 11-12
Color Variation drop-down menu (Edit
Template page), 219-220
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columns

changing number of, 159-160

for modules in Module Manager, 183
community, for Joomla, 14
Community Portal, 292
Compass Designs Web site, 302

template tutorial, 307, 308

templates, 303-304
components

articles and, 46

configuring, 276-277

finding and installing, 276

menu item for, adding, 277-278

modules compared to, 264-265
Components>Banner~>Banners, 187
Componentst>Contacts~>Contacts, 241
Componentsoname, 276
Components=>Polls, 68
configuration.php file

description of, 26

writable, 28
configuring

Archive module, 190-191

built-in FTP server, 31

components, 276-277

modules, 186-187

to use mod-rewrite module, 254
connecting to site via FTP, 21
contact, adding to site, 241-242, 243
Contact Manager

accessing, 241

description of, 240
contact page

creating, 242-244

description of, 240
Contact Parameters pane (Contact

Manager), 242

content management systems (CMSes)

description of, 1, 8

dynamic Web pages via, 13-14

HTML pages and, 11-12
Content>Article Manager, 64, 147
Content=>Article Trash, 121
Content>Category Manager, 99

Content>Section Manager, 96
Control Panel (XAMPP), 37
control panel, administrator
Add New Article icon, 50
administrator privileges, granting, 47-48
description of, 46-47
logging in to, 43-44
managers, 44, 48-49
user privileges, granting, 47
CopesFlavio.com module tutorial, 313
copyright notice, 199-201
core features Web site, 294
CSS (Cascading Style Sheets), 12-13
CSS (Cascading Style Sheets) file, templates
and, 75
Custom HTML module, 194-197
customizing template, 219-220

o e

database, connecting to, 29-30
Database Configuration page, 29-30, 31
Database Information page (Go Daddy), 25
Database summary (Go Daddy), 23, 24
date, setting

to end publication of article, 163-164

to start publication of article, 162-163
default appearance of site, 15, 16
default editor

changing, 195

enabling, 197
default front page

Archive module on, 191

elements of, 45-46

Key Concepts menu, 168

modules and components on, 264
default logo

changing, 74-75

description of, 73-74
default menu item, setting, 144-145
deleting. See also removing

installation directory, 33

menu items, 120-121

menus, 60-62

modules, 59
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Description text box (New Category
page), 125

Details pane

administration page, 185

Contact Manager, 241

Random Image module, 203

Related Items module, 206
disabling

default editor, 195

[IS (Internet Information Services), 37

user account, 235
displaying

article-to-article links, 144

list of archived articles, 190-191

newsflash articles, 71, 72-73

RSS feeds, 197-198
docs.joomla.org template tutorial, 309, 310
down, taking site, 177-178
downloading

extensions, 269-270

Joomla, 17-18

Lonex template, 228

security and, 228
Drop Existing Tables option, 31
dynamic page, 251

oF o

Edit CSS button (Edit Template page),
76, 221
Edit HTML button (Edit Template page), 221
Edit icon, 174-175
Edit Template page
Edit HTML and Edit CSS buttons, 221
logo, adding in, 75, 76
options, 219-220
Edit User page, 234-235
Edit Your Details page, 247-248
editing
ad, 188
Banner module, 193
built-in template, 218-220
code for built-in template, 220-227
Related Items module, 205-206
Search module, 208-209
template.css file, 224-227
users, 234-235

editor. See also article editor; TinyMCE
default, changing, 195
default, turning on, 197
JCE, 286
WYSIWYG, 50, 151, 286, 287
Editor user level
creating account, 237, 238
description of, 47, 165-166, 233
options for, 174-176
e-mail, managing, 245
emoticon, adding to article, 151-152
emptying trash, 120-121
enabling
default editor, 197
legacy mode, 269
PixSearch module, 273, 275
Wrapper module, 213
XStandard Lite plug-in, 151
events calendar extension, 289, 290
Exposé Flash Gallery, 289, 290
extensibility, 227
Extension Manager
accessing, 229
Install/Uninstall page, 273-274
Package File text box, 271
extensions. See also plug-ins
choosing, 268-269
components, installing, 276-278
downloading, 269-270
Exposé Flash Gallery, 289, 290
game module, installing, 271-272
JCE editor, 286
JEvents calendar, 289, 290
Joom!Fish, 286, 287
JoomlaPack, 288
MetaMod, 288
modules, 264-265
My Blog, 286, 287
overview of, 263
ratings of, 269, 283
searching for, 266-268
sh404SEF plug-in, 255-256, 288-289
top ten, 284-290
utility module, installing, 272-275
VirtueMart, 284, 285
Xmap, 284, 285
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Extensions drop-down menu
(administrator control panel), 49

Extensions site

categories, 267-268

choosing item from, 268-269

downloading from, 270

links, 267

search box, 266
Extensions>Install/Uninstall, 229
Extensions=>Module Manager, 56
Extensions=>Plugin Manager, 151
Extensions=>Template Manager, 75, 216

ofF e

Feed Display module, 197-198
file. See also image file
CSS, templates and, 75
configuration.php, 26, 28
GIF, 74
index.php, 26, 224
index.rss, 211
JPG, 74
.png, 74
template.css, 221-227
uploading to host server, 21-22
.zip, 228
filename, changing in Windows
Explorer, 255
FileZilla, uploading files to host server
using, 21-22
filtering
articles, 65-66, 113
uncategorized articles, 88
Finish page, 33-34
Finish Publishing text box (article editor),
164-165
Footer module, 199-201
formatting. See also templates
articles with HTML tags, 154-156
tables, 157-159
forums, 292
front end, 46

front page, default

Archive module on, 191

elements of, 45-46

Key Concepts menu, 168

modules and components on, 264
FTP configuration, setting up, 30-31

o(Go

game module, installing, 271-272
General tab (Insert/Modify Table dialog
box), 156-157
GIF file, 74
Global Checkin command (Tools menu), 86
Global Configuration page
accessing, 56
New User Registration Type list, 236
removing author names from articles, 143
SEO Settings pane, 252, 254
taking site offline, 177-178
User New Account Activation option, 236
Go Daddy ISP
collecting database details, 25
creating database in, 22-24
installation by, 20-21
Google AdWords tool, 256, 257
Google search engine, 262, 272-273
Graffiti template (Lonex), 228-230

o o

help system, 291-294
help.joomla.org installation tutorial, 309,
310
hiding author name, 142-144
Hits column (Article Manager), 176-177
host server, installing Joomla on
accepting license, 29
connecting to database, 29
finishing installation, 33-34
FTP configuration, setting up, 30-31
main configuration, setting up, 31-33
MySQL, setting up, 22-25
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overview of, 20-21

preinstallation check, 27-29

selecting language, 26-27

uploading files, 21-22
HTML Source Editor window, 154-155
HTML tags, formatting article with, 154-156

o]e

iBusiness Promoter software, 262
IIS (Internet Information Services),
disabling, 37
image file
adding to articles, 152-154
for banner ads, 192-193
section, 97-98
image-insertion dialog box, 153
images/banners directory, 192
images/stories directory, 153
Increase Counter text box (Statistics
module), 210
index.php file, 26, 224
index.rss file, 211
Information pane (Contact Manager), 241
Insert Emotion dialog box (TinyMCE), 152
Insert or Edit Media button (TinyMCE), 154
inserting page break, 161
Insert/Modify Table dialog box, General
tab, 156-157
Install Sample Data command button,
32,33
installation directory, removing, 33
installation manual Web site, 294
installing. See also installing Joomla locally;
installing Joomla on host server
components, 276
game module, 271-272
Joomla, 17, 309, 310
plug-ins, 255, 279
template, 229-230
utility module, 272-275
installing Joomla locally
hard way, 35
overview of, 33-34

software, installing, 40
XAMPP, installing, 35-39
installing Joomla on host server
accepting license, 29
connecting to database, 29
finishing installation, 33-34
FTP configuration, setting up, 30-31
main configuration, setting up, 31-33
MySQL, setting up, 22-25
overview of, 20-21
preinstallation check, 27-29
selecting language, 26-27
uploading files, 21-22
Install/Uninstall page (Extension Manager),
273-274
interaction
adding and managing users, 166-167
article submission page, creating,
167-170
article submission page, viewing link to,
170-171
overview of, 165-166
internal link, creating, 89, 90
Internet Information Services (IIS),
disabling, 37
Item Saved message, 62, 63

° ] °
JCE editor, 286
<jdoc:include> element, 227
Jenerate site, 9, 11
JEvents calendar, 289, 290
Joom!Fish extension, 286, 287
Joomla
advantages of, 14-15
Community Portal, 292
core features, 294
forums, 292
help site, 291
installation manuals, 26, 294
Official Documentation Wiki site, 292
popularity of, 14
Quick Start Guide, 293



326

Joomla! For Dummies

Joomla (continued)

Quick Start Videos, 293

Template Tutorial, 305-306

translation teams, 293

user groups, 293

Web site, 15, 16

Wikipedia site, 292
Joomla Extensions Directory, 253, 255
JoomlaPack extension, 288
Joomlaport.com tutorial, 307, 309
Joomlart.com Web site, 303
Joomlashack Web site, 228, 297
JoomlaShine Web site, 298, 300
Joomla-Templates.com Web site, 295, 296
JoomlaTP.com Web site, 298, 299
Joomlatutorials.com Web site, 307, 308
Joomla24.com Web site, 228, 298, 299
JPG file, 74

oK o

Key Concepts menu, 168, 170-171
keyword
adding as metadata, 257-258
for articles, 204-206
finding, 256-257
for search engines, 252
Keywords text box (Article Manager),
257-258
Khepri administrator template, 217

o/ o

L (language) icon, 269
language directory, 200, 201
languages
content in multiple, 286, 287
selecting, 26-27
layout of site, planning, 84-85
Legacy mode, 268
license, accepting, 29
link
article-to-article, showing, 144
Extensions site, 267
in login form, 201-202

Read More, creating, 109-112
search engine optimization and, 261
turning article title into, 139-140
linking article to menu item
Article Layout page and, 93
creating menu items, 88-91
overview of, 88
setting menu item attributes, 92
testing new menu items, 94-95
linking category to menu item
category menu item creating, 107-109
overview of, 106
Linux, XAMPP for, 38-39
list layout
applying to articles in category, 130-136
changing article order in, 134-136
description of, 130
viewing, 134
Live Search search engine, 262
locally, installing Joomla
hard way, 35
overview of, 33-34
software, installing, 40
XAMPP, installing, 35-39
logging in as administrator, 43-44, 48
Login Form module, 201-202
logo
default, changing, 74-75
default, description of, 73-74
new, adding to template, 75-78
size of, changing, 79
Lonex Web site, 228

ol o

M (module) icon, 269
Mac, XAMPP for, 39
mail message for administrator, 172,
173-174
Main Configuration page, 33
main configuration, setting up, 31-33
Main menu
adding articles as separate menu
items, 105
adding items that point to categories, 106
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adding items that point to sections, 106

contents of, 42
items in, 60-61
with menu separator, 146
new parent menu item in, 128
new submenu items in, 130
Manage Account link (Go Daddy), 23
Manager administrator user level
creating account, 239
description of, 47, 234
managers. See also specific managers
in administrator control panel, 48-49
in Extensions drop-down menu, 49
icons for, 44
Mass Mail function, 245
Menu Assignment pane
administration page, 186
Edit Template page, 220
Random Image module, 203
Related Items module, 206
menu item
adding to Main menu, 105-106
attributes, setting, 92
category, creating, 107-109
for component, adding, 277-278
creating, 88-89, 132-133
default, setting, 144-145
deleting, 120-121
formatting options and, 88
linking articles to, 88-95
News, 250
order of, changing, 133-134
overview of, 123-124
parent, creating, 128
Separator type, 146
setting position of, 116-121
submenu items, creating, 124-130
testing new, 94-95
unpublishing, 61, 119-120
Menu Item Manager
Access Level list, 141
accessing, 53, 54
On Click, Open In list options, 142
Default column, 144-145
New Menu Item page, 89, 90, 168
Order column, 116, 118

Parameters - Basic section, 159-160
reordering items in, 134
setting menu item position in, 116-121
Menu Manager
accessing, 53, 59
Published column, 164-165
menu options
access, setting, 141
Article Layout page, 137-139
article-to-article link, showing, 144
hiding author name, 142-144
opening articles in new windows, 141-142
showing article ratings, 140-141
turning article titles into links, 139-140
menu separator, creating, 145-146
menu structure, choices for linking articles
to menu items, 104
menu-item layout page. See Article
Layout page
menus. See also Main menu
default front page, 41-42, 45, 46
Key Concepts, 168, 170
modifying, 59-60
in Module Manager, 57
removing, 60-62
renaming, 62-63
Menus=>Menu Trash, 121
message
Item Saved, 62, 63
mail, for administrator, 172, 173-174
private, sending or receiving, 245
metadata, adding keyword as, 257-258
Metadata Information pane (Article
Manager), 258
Metadata options (article editor),
150, 205-206
MetaMod extension, 288
Microsoft. See also Windows
ISS (Internet Information Services),
disabling, 37
Paint, accessing, 74
Migration Guide, 32
Milky Way template
changing, 79, 80, 218
as default, 73
as site template, 217
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minimum requirements, 18-20
mod_rewrite module, 253-254
module management extension, 288
Module Manager
accessing, 56
columns for modules in, 183
modules in, 182
navigating, 57
overview of, 181-182
Module Parameters pane
Edit Module page, 271-272
Random Image module, 204
Search module, 208
Wrapper module, 214

modules. See also administration page

(Advertisement module)
Advertisement, 183-184, 187-189
Archive, 189-191
Banners, 191-193
Breadcrumbs, 94, 194
components compared to, 264-265
Custom HTML, 194-197
default front page, 45, 46
Feed Display, 197-198
Footer, 199-201
front-page management and, 42-43
game, installing, 271-272
Login Form, 201-202
mod_rewrite, 253-254
Newsflash, 58
overview of, 181-183
Polls, 67-68
Popular, 202
Random Image, 203-204
Related Items, 204-206
removing and deleting, 58-59
Search, 206-209
Section, 209
Statistics, 209-210
Syndication, 211-212
tutorial on, 313
utility, installing, 272-275
viewing, 57-58
Who's Online, 212-213
Wrapper, 58, 213-214

multimedia, inserting into article, 154
My Blog extension, 286, 287
MySQL
case sensitivity of, 30
download Web site, 35
MySQL, setting up
database, creating, 22-24
database details, collecting, 25

o\ o

Native mode, 268, 283
Needforcontent.com, CMS Tutorials and
Reviews section, 312
New Category page
Category Manager, 99-100
Description text box, 125
New Menu Item page
component, adding menu item for,
277, 278
contact page, creating, 243-244
node tree, 107
User entry, 246
New Section page (Selection Manager), 98
new site
menus, 41-42
modules, 42-43
with sample data, 41
New User page (User Manager), 236-237
New User Registration Type list (Global
Configuration page), 236
News menu item, 250
newsflash, changing default, 71-73
Newsflash module, 58
NZMac.com site, 9, 10

o () o

Official Documentation Wiki site, 292
offline, taking site, 177-178

offline requirements, 20

1.0 Native icon, 268

1.5 Native icon, 283

online requirements, 18-20
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online store system, 284, 285
opening. See also accessing
articles in new windows, 141-142
polls, 68-69
optimizing site for search engine
automating, 262
keywords and, 256-258, 261
making URLs search engine friendly,
252-256
metadata and, 258
overview of, 249
templates and, 259-260
tips for, 260-261
order, changing
of articles, 112-116
of articles in list layout, 134-136
of menu items, 116-121, 133-134
Order column (Menu Item Manager),
116, 118
Order option (Details pane), 185
organizing Web sites
article order, changing, 112-116
with categories, 84, 98-104
linking articles to menu items, 88-95
linking categories to menu items, 106-109
menu item position, setting, 116-121
menu structure, choosing, 104-106
overview of, 83-84
planning layout, 84-85
Read More links, creating, 109-112
with sections, 84, 95-98
uncategorized articles, working with,
85-88

oo

P (plug-in) icon, 269

Package File text box (Extension
Manager), 271

Pagebreak button (article editor), 161

Paint (Microsoft), accessing, 74

Parameters pane (administration page),
186-187

Parameters - Advanced section
article editor, 149-150
Article Layout page, 137-138
Category Blog Layout page, 115
Parameters - Article options (article
editor), 149, 163
Parameters - Basic section
Article Layout page, 93, 137
Menu Item Manager, 159-160
Parameters - Component section (Article
Layout page)
Article Rating/Voting drop-down
menu, 141
Hide from the Author Name drop-down
menu, 142-143
options, 138-139
Title Linkable drop-down menu, 139-140
Parameters - System section (Article
Layout page), 139
parent menu item, creating, 128
password, administrator, 32
permitting user
to edit account, 246-248
to manage account, 246
PHP download Web site, 35
phpinfo function, 253
pill menu, 42
pipe underscore (|_) characters
(submenu), 61
PixSearch module, installing, 273-275
platform for extension, choosing, 268
Plugin Manager
accessing, 151
System-Legacy plug-in, 269
plug-ins
description of, 265
installing, 279
to make URLs search engine friendly,
255-256
System-Legacy, 269
XStandard Lite, 151
.png file, 74
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poll

creating, 70-71

default, changing, 68-70
Poll Manager, accessing, 68
Polls module, 67-68
Popular module, 202
Portable Network Graphics (PNG) file, 74
Position option (Details pane), 185
Pre-installation Check page, 27-29
Preview link (back-end page), 230
previewing

section image, 98

template, 80
Privacy Policy page, 94, 95
private message, sending or receiving, 245
Private Messaging page, 174
privileges, granting, 47-48, 246-248
PUArcade extension, 268
Public user level, 47, 233
Publisher user level

creating account, 238-239

description of, 233, 47, 165

options for, 176
publishing articles in future, 162-163
Purity template

description of, 79

as site template, 217

.Q.

question mark (?) character, and dynamic
page, 251

Quick Start Guide, 293

Quick Start Videos, 293

o R o

Random Image module, 203-204
ratings

of articles, 140-141

of extensions, 269, 283
Read More link, creating, 109-112
reading submitted article, 174

Really Simple Syndication (RSS) feed
adding, 197-198
Syndication module and, 211-212
receiving private message, 245
Registered user level
creating account, 235-237
description of, 47, 233
Registration page, 201-202
Related Items module, 204-206
removing
author name from article, 142-144
banner ad, 94
installation directory, 33
menus, 60-62
modules, 58-59
renaming
menus, 62-63
Random Image module, 204
reordering articles
in Article Manager, 113-114
in category page, 114-115
overview of, 112-113
reordering menu items, 116-121, 133-134
resetting number of hits to zero, 177
Resources menu, 42
results page, search controls, 207-208
Robb Luther YouTube tutorial, 311
Royal Oak Public Library site, 9, 10
RSS (Really Simple Syndication) feed
adding, 197-198
Syndication module and, 211-212

oS e

S (special, extension-specific code) icon,
269
sample sites, 8-11
Save button (article editor), 52, 86
search button, adding, 209
search engine
overview of, 250-251
submitting sites to, 262
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search engine optimization
automating, 262
keywords and, 256-258, 261
making URLs search engine friendly,
252-256
metadata and, 258
overview of, 249
templates and, 259-260
tips for, 260-261
Search Engine Rankings software, 262
Search module, 206-209
searching for extension, 266-268
Section drop-down menu (article-selection
page), 93
Section Manager
accessing, 96
applying image to section, 98
creating section, 96-97
description of, 95
section page, creating, 124-125
sections
adding menu items to Main menu that
point to, 105-106
built-in, 95
categories and, 84
changing section category is assigned
to, 99
creating, 95-96
description of, 83-84
dividing sites into, 84
selecting image for, 97-98
Sections module, 209
security, downloading and installing
templates and, 228
security bar, 270
selecting
article layout, 89, 91
newsflash article to display, 71, 72-73
sending private message, 245
SEO Book Keyword Suggestion Tool, 256
SEO Settings pane (Global Configuration
page), 252, 254
settings, recommended, 28
Setup Wizard (XAMPP for Windows), 36

sh404SEF plug-in, 255-256, 288-289
site map, 276-278, 284, 285
Site tab (Module Manager), 57
site template
default, changing, 218
overview of, 217
Site=>Control Panel, 53
Siter>Global Configuration, 56
SiteGround Web site, 295, 296, 305
SiteSolutions.com software, 262
Site>User Manager, 166
slideshow extension, 289, 290
software
to automate search engine
optimization, 262
downloading, 18
unzipping, 18
spidering, 250-251
Start Publishing text box (article
editor), 163
StartoProgramst>AccessoriestPaint, 74
static page, 251
Statistics module, 209-210
stopping publishing in future, 163-164
submenu characters (1_), 61
submenu item, creating, 124-130
submitting
articles, Author user level and, 172, 173
sites to search engines, 262
Sudoku module, installing, 271-272
Sudoku page, 270
Super Administrator user level
creating account, 240
description of, 32, 47, 234
switching between templates, 79-80
Syndication module, 211-212
system parameters, displaying, 54, 55
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table
creating in articles, 156-157
example of, 156
formatting, 157-159
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table of contents, creating, 160-162
Table Row Properties dialog box
(TinyMCE), 158
target Web page, creating, 126-127
Template CSS Editor page, 76, 77, 221-222
template editor, third-party, 216
Template Manager
accessing, 76, 216
switching between templates with, 79-80
Template Monster Web site, 301
Template Tutorial, 305-306
Template Width drop-down menu (Edit
Template page), 220
template.css file
editing, 224-227
viewing, 221-224
template.css page, 76, 77
templates
adding new logo to, 75
administrator, 217
built-in, editing, 218-220
built-in, editing code for, 220-227
changing, 79-80
default, changing, 230
default site, changing, 218
formatting sites with, 215-216
Graffiti (Lonex), 228-230
installing, 229-230
previewing, 80
search engine optimization and, 259-260
site, 217, 218
top ten sites for, 295-304
tutorials on, 305-306, 307, 308, 309, 310
version of Joomla and, 228
testing new menu item, 94-95
time out setting, changing, 56
TinyMCE
description of, 150-151
formatting articles with HTML tags,
154-156
HTML tags and, 194
Insert Emotion dialog box, 152
Insert or Edit Media button, 154
Table Row Properties dialog box, 158
Update All Cells in Table option, 158-159

Title Linkable drop-down menu, 139-140
title of article

turning into links, 139-140

tweaking, 53-55
Tools=>Global Checkin, 86, 176
ToolsoMass Mail, 245
Toolsw>Read Message, 245
Tools=>Write Message, 245
top menu, 42
tracking page hits, 176-177
translation team, 293
translations of article, 286, 287
Trash Manager, accessing, 121
trashing menu item, 120-121
turning off default editor, 195
turning on default editor, 197
tutorials, 305-313

olf o

uncategorized article
creating, 86-87
description of, 85
filtering, 88
unpublishing
articles, 6667
articles in present, 164-165
Banners module, 94
menu items, 61, 119-120
unzipping software, 18
Update All Cells in Table option
(TinyMCE), 158-159
uploading file to host server, 21-22
URL, making search engine friendly
with mod_rewrite module, 253-254
by turning on option, 252
user. See also user interaction
contact page for, 241-244
permitting to manage or edit account,
246-248
privileges, granting, 47, 233-234
User Form Layout page, 246-247
user groups, 293



user interaction
adding and managing users, 166-167
article submission page, creating, 167-170
article submission page, viewing link to,
170-171
overview of, 165-166
User Manager
adding and managing users, 166-167
New User page, 236-237
overview of, 234
User New Account Activation option
(Global Configuration page), 236
user-created account, Registered user, 236
user-management page, creating, 246
username, admin, 240
utility module, installing, 272-275

o[/ e

viewing
articles, 64-65
Banner module, 192, 193
CSS file, 221-224
link to article submission page, 170-171
list layout, 134
modules, 57-58
VirtueMart extension, 284, 285

o[/ o

Web CEO software, 262
Web Page Analyzer software, 262
Web sites. See also Web sites, organizing
Apache Web server, 35
extensions, 266
FileZilla, 21
free templates, 228
Go Daddy, 20
installation instructions, 26
Joomla, 15, 16
Joomla Extensions Directory, 253
Joomla help, 291-294
Migration Guide, 32

MySQL, 35
PHP, 35
samples of, 8-11
search engine optimization, 262
search engines, 262
taking offline, 177-178
templates, 295-304
tutorials, 305-313
WinZip for Windows, 18
XAMPP, 35, 37
Web sites, organizing
article order, changing, 112-116
with categories, 84, 98-104
linking articles to menu items, 88-95
linking categories to menu items, 106-109
menu item position, setting, 116-121
menu structure, choosing, 104-106
overview of, 83-84
planning layout, 84-85
Read More links, creating, 109-112
with sections, 84, 95-98
uncategorized articles, working with,
85-88
WebPosition 4 software, 262
Who'’s Online module, 212-213
width options (Edit Template page), 220
Wikipedia site, 292
window, opening article in new, 141-142
Windows
Explorer, changing filename in, 255
WinZip for, 18
XAMPP for, 36-38
XStandard Lite plug-in, 151
WinZip for Windows, 18
Wordtracker Keywords, 256
Wrapper module, 58, 213-214
Writable status (Template CSS Editor
page), 221
WYSIWYG editor
article editor as, 50
JCE as, 286, 287
TinyMCE as, 151
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o X o
XAMPP for Windows documentation
page, 38
XAMPP, installing, 35-39
Xmap component
description of, 284, 285
installing, 276-278
XStandard Lite plug-in, 151

oyo

Yahoo! search engine, 262

o/ o

.zip file, 228















